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Utiliser LibreOffice sur un Mac

Sur Mac, certaines touches et certains éléments de menu sont différents de ceux utilisés sous
Windows ou Linux. Le tableau ci-dessous donne quelgues substitutions courantes pour les
instructions de ce chapitre. Pour une liste plus détaillée, voyez I'Aide de I'application.

Windows ou Linux | Equivalent Mac Effet
Sélection du menu | LibreOffice > Préférences Acces aux options de configuration
Outils > Options
Clic droit Control+clic ou clic droit | Ouvre un menu contextuel
selon la configuration de
I'ordinateur
Ctrl (Control) 3 (Command) Utilisé avec d’autres touches
F5 Shift+(gg]+F5 Ouvre le Navigateur
Fi1 #B+T Ouvre la fenétre Styles et Formatage

La documentation francaise de LibreOffice est disponible a
https.//wiki.documentfoundation.org/Documentation/Publications/fr
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Introduction

Vous pouvez ajouter des fichiers graphiques et d'images, y compris des photos, des dessins et
des images scannées aux documents de LibreOffice. Il peut importer divers formats de fichiers
vectoriels (dessins au trait) et matriciels (bitmap). Les formats graphiques les plus couramment
utilisés sont GIF, JPG, PNG et BMP. Voyez I'Annexe B pour une liste compléte des formats
graphiques que LibreOffice peut importer.

Les objets graphiques dans LibreOffice appartiennent a trois types de base :

* Les fichiers d'image tels que les photos, les dessins et les images scannées.
* Les schémas créés avec les outils de dessin de LibreOffice.
* Les diagrammes créés avec le composant Diagramme de LibreOffice.
Ce chapitre traite des images et des schémas.
Une description plus détaillée du travail avec les outils de dessin se trouve dans le Guide Draw et

le Guide Impress. Les instructions pour la création de diagrammes sont données dans le Guide
Calc.

Ajouter des images a un document

On peut ajouter des images a un document de plusieurs maniéres : en insérant un fichier image,
directement a partir d'un programme graphique ou d’'un scanner, en les tirant depuis la galerie de
clip-arts interne ou en les copiant/collant depuis une source ouverte sur votre ordinateur.

Insérer un fichier image

Quand limage est dans un fichier stocké sur votre ordinateur, vous pouvez l'insérer dans un
document de LibreOffice en utilisant 'une des méthodes suivantes.

Par glisser-déposer
1) Ouvrez le navigateur de fichiers et recherchez I'image que vous voulez insérer.

2) Tirez cette image dans le document de LibreOffice et déposez-la ou vous voulez la voir
apparaitre. Une fine ligne verticale marque I'endroit ou I'image sera déposée.
Cette méthode incorpore le (enregistre une copie du) fichier image dans le document. Pour lier le
fichier au lieu de I'incorporer, maintenez appuyées les touches Ctrl+Maj pendant que vous tirez
'image.

Avec la boite de dialogue Insérer une image

1) Cliquez dans le document de LibreOffice ou vous désirez voir apparaitre I'image.

2) Sélectionnez le menu Insertion > Image dans la barre de Menu.

3) Dans la boite de dialogue Insérer une image (Figure 1), recherchez I'image que vous
voulez insérer et sélectionnez-la.

4) 1l y a une option en bas de la boite de dialogue : Lier. Voir page 8 pour l'utilisation de
I'option Lier.
Si vous utilisez les boites de dialogue de LibreOffice, vous disposez aussi d’'une option
Apercu qui vous offre une vue réduite de I'image sélectionnée dans le panneau a droite de
la boite de dialogue. Vous pouvez ainsi vérifier que vous avez choisi le bon fichier.
Si vous utilisez les boites de dialogue propre a votre systéme d’exploitation, celui-ci
propose peut-étre aussi une fonction équivalente.

5) Cliquez sur Ouvrir.
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' Remarque

Si vous cochez 'option Lier, un message apparait quand vous cliquez sur Ouvrir pour

vous demander si vous ne désirez pas plutdt incorporer l'image. Cliquez sur

Conserver le lien si vous voulez effectivement la lier ou, sinon, sur Incorporer
I'image. Pour éviter que ce message apparaisse de nouveau, décochez I'option
Demander lors de I’'ajout d’un lien & une image en bas du message.

ZhI\Mes documents'Mes autres imagestlmages téléchargées ~ | | Serveurs... @ R

Signets MNom Type de contenu Taille Date de

[ Mes document B 102355vg
=3 182520main_image_feature_ Images (jpg) 816,0 Ko 19/07
[55 Folderjpg Irmages (jpg) 4189 Octets 06/10
| Joyeux noel.svg SVG-Fichier 884 Ko 2212
EI Le monde vu par I'&mérique Images (jpg) 49,9Ke 11/03
= lendon9.jpg Images (jpg) 3299 Ko 31/08
EI Pont Valentré a CahorsJPG  Images (jpg) 263,0 Ko 20405

L= [5] Rocamadour.JPG Images (jpg) 281,1Ko 20/05 w

Mom de fichier: | 10235.5vg i

Type de fichier: |<Tu:|us les formats> ("bmp;™.dxf; " emf, " eps®.gif, " jpg:* jpeg; ™ jfif] |

[ Lier Apercu

Insérer une image “

MERRY CHRISTMAS TO ALL!!

Annuler

Aide

Figure 1 : La boite de dialogue (de LibreOffice) Insérer une image

Lier un fichier image

Si I'option Lier est cochée dans la boite de dialogue Insérer une image, LibreOffice crée un lien
vers le fichier qui contient I'image au lieu d’en enregistrer une copie dans le document. Il en résulte
gue l'image s’affiche dans le document mais, quand on enregistre celui-ci, il ne contient qu'une
référence au fichier image et non I'image elle-méme. Le document et I'image restent deux fichiers
séparés qui ne sont fusionnés qu'au moment ou vous ouvrez le document.

Lier une image présente deux avantages et un inconvénient ;

Avantage — la liaison peut réduire la taille du document enregistré, car le fichier image
n'est pas lui-méme inclus. La taille du fichier n’est normalement plus un probléme sur les
ordinateurs modernes qui possédent une quantité raisonnable de mémoire, a moins que le
document ne comporte beaucoup de grands fichiers images : LibreOffice sait gérer d’assez
grands fichiers.

Avantage — vous pouvez modifier le fichier image séparément sans changer le document,
car le lien vers le fichier reste valide et I'image modifiée apparaitra la prochaine fois que
vous ouvrirez le document. Cela peut constituer un gros avantage si vous (ou quelqu’un
d’autre, peut-étre un artiste en graphisme) met a jour les images.

Inconvénient — Si vous envoyez le document a quelgu’un d’autre, ou si vous le déplacez
vers un autre ordinateur, vous devez aussi envoyer les fichiers d'images ou celui qui
recevra le document ne pourra pas voir les images liées. Vous devez garder la trace de
'emplacement des images et vous assurez que celui qui les recevra sait ou les mettre sur
sa machine pour que le document les retrouve. Par exemple, vous devez placer les images
dans un sous-dossier appelé Images (dans le dossier qui contient le document) ; le
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destinataire du fichier devra mettre les images dans un sous-dossier de méme nom et au
méme emplacement par rapport au document.

’ Remarque

Quand vous insérez plusieurs fois la méme image dans le document, vous devriez voir
lintérét de lier plutét que d’incorporer; ce n'est cependant pas obligatoire car
LibreOffice n’incorpore qu'une seule copie du fichier image dans le document.

Comment incorporer des images liées
Si vous avez initialement lié des images, vous pouvez facilement en incorporer une ou plusieurs
d’entre elles si vous le désirez. Pour cela :

1) Ouvrez le document dans LibreOffice et sélectionnez le menu Edition > Liens.

2) La boite de dialogue Editer les liens (Figure 2) montre tous les fichiers liés. Dans la liste
Fichier source, sélectionnez les fichiers que vous voulez incorporer.

3) Cliquez sur le bouton Déconnecter puis sur OK dans le message de confirmation.
4) Enregistrer le document.

Editer les liens “

Fichier source Elément : Type Statut
g Fermer

Folder.jpc < Tous les formats> Image Manuel

Le monde vu par I'Amérique < Tous les formats= Irmage Manuel i

10235.5vg = Tous les formats» Image Manuel Aide
Actualiser
Modifier...

Déconnecter

Fichier source  file:///Z:/Z/Mes documents/Mes autres images/Images téléchargées/Folder.jpg

Elément : <Tous les formats>
Type: Image
Actualiser: Automatique Manuel

Figure 2 : La boite de dialogue Editer les liens

' Remarque

Transformer une image incorporée en image liée n'est pas aussi facile : vous devez
remplacer les images une a une en choisissant I'option Lier a chaque fois.

Insérer une image du presse-papier

Grace au presse-papier, vous pouvez copier, dans un document de LibreOffice, des images
provenant d'un autre document de LibreOffice ou d’autres programmes. Pour cela :

1) Ouvrez le document source et le document cible a la fois.

2) Dans le document source, sélectionnez I'image a copier.

3) Appuyez sur Ctrl1+C pour copier I'image dans le presse-papier.

4) Passez au document cible.

5) Cliquez pour placer le curseur a I'endroit ot I'image doit étre insérée.
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6) Appuyez sur Ctrl+V pour insérer I'image.

>
.' Attention

Si vous fermez l'application ou lI'image a été copiée avant de la coller dans la cible,
'image contenue dans le presse-papier peut étre perdue.

Insérer une image avec un scanner

Si un scanner est connecté a votre ordinateur, LibreOffice peut appeler I'application du scanner et
insérer I'élément scanné dans le document en tant qu'image. Pour commencer, placez le curseur a
I'endroit ou vous désirez insérer I'image et sélectionnez le menu Insertion > Média > Scanner >
Sélectionner la source.

Bien que cette méthode soit simple et rapide, il est peu probable gu’elle produise une image de
haute qualité et de la taille correcte. Vous pouvez obtenir de meilleurs résultats en transmettant
'image scannée a un programme de retouche d'image pour la nettoyer avant d’insérer le résultat
dans LibreOffice.

Insérer une image de la Galerie

La Galerie (Gallery) (Figure 3) offre une facon pratique de grouper des objets réutilisables tels que
des images et des sons que vous pouvez insérer dans vos documents. Elle est disponible dans
tous les modules de LibreOffice. Voir « Gérer la Galerie de LibreOffice » page 12. Vous pouvez
copier ou lier un objet de la Galerie dans votre document.

Galerie )

Nouveau théme...

= Personne

Figure 3 : La Galerie dans le Volet latéral

Pour insérer un objet :

1) Cliquez sur licone de la Galerie dans le Volet latéral, ou sélectionnez le menu
Insertion > Média > Galerie Clip Art.
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2) Choisissez un théme.
3) Choisissez un objet par un clic unique.
Pour incorporer I'objet dans le document :

4) Tirez et déposez I'image dans le document.

Vous pouvez aussi faire un clic droit sur I'objet et sélectionner Insérer dans le menu
contextuel.

Pour lier I'objet au document :
5) Tout en appuyant sur les touches Maj et Ctrl, tirez et déposez I'objet dans le document.

Insérer une image comme arriére-plan
Pour insérer une image comme arriére-plan d’'une page ou d’'un paragraphe :

1) Sélectionnez le menu Insertion > Média > Galerie et choisissez un théme.

2) Choisissez un objet par un clic unigue, faites un clic droit sur I'objet et sélectionnez Insérer
comme arriére-plan > Page ou Paragraphe.

Modifier et positionner les images

LibreOffice propose de nombreux outils pour recadrer, changer la taille, modifier, appliquer des
filtres et positionner les images ; pour disposer le texte autour des images ; et pour utiliser des
images comme arriére-plans ou filigranes. Ces outils sont décrits dans les chapitres concernés des
autres guides. Il vaut mieux effectuer certains ajustements complexes dans un programme de
traitement d’'images et de réinsérer le résultat dans LibreOffice plutdét que d’utiliser ses outils
internes.

Exporter des images

Si vous devez faire des modifications complexes dans un image, ou si vous désirez la sauvegarder
pour l'utiliser dans un autre document, vous pouvez exporter I'image directement depuis votre
document. Faites un clic droit sur I'image pour la sélectionner et ouvrir le menu contextuel.
Choisissez ensuite Enregistrer pour ouvrir la boite de dialogue Export d’image. Selon le format
original de l'image, LibreOffice vous permettra de I'enregistrer sous de nombreux formats
différents. Donnez-lui un nom, choisissez le format souhaité dans la liste Type et cliquez sur
Enregistrer.

Compresser des images

Si vous insérez une grande image dans votre document avant de modifier ses dimensions pour
gu’elle tienne dans la page, I'image originale est toute entiére stockée dans le fichier du document
pour préserver son contenu, ce qui produit un gros fichier a stocker ou a envoyer par mail.

Si vous pouvez accepter une certaine perte de qualité dans le rendu de l'image ou si vous voulez
en modifier la taille, vous pouvez compresser ou ajuster la taille de I'objet image pour diminuer la
quantité de données qu'il représente tout en préservant la fagon dont il s’affiche dans la page.

Faites un clic droit pour sélectionner I'image et ouvrir le menu contextuel. Choisissez ensuite
Compresser pour ouvre la boite de dialogue Compresser l'image (Figure 4). Noter que le bouton
Calculer met & jour les informations sur I'image a chaque modification d'un paramétre. Cliquez sur
OK pour appliquer les réglages de compression. Si le résultat ne vous convient pas, appuyez sur
Ctrl1+Z pour annuler I'opération et recommencez avec d'autres réglages. Voyez I'Aide pour plus
d’informations.
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Compresser |'image

Options de compression Informations sur I'image
® Compression JPEG: Type: Image PNG
Qualité: 90 = Dimensions réelles : 7,78 cm x 10,56 cm (294 x 399 px)
I Dimensions apparentes : 7,78 cm x 9,90 cm a 96 DPI
Taille de I'image : 17 kio
@ Lom s S0 e Nouvelle taille : 2
Compression: |9 c
Calculer
Reéduire la résolution des images
Largeur: 293 - px
Hauteur: 374 - px
Résolution: 96 ~| DPI
Interpolation : |Lanczos =
Aide OK Annuler
Figure 4 : Compresser une image
Gerer la Galerie de LibreOffice
Gallery x

@ Personne

ﬁ Puces
B9 Sons
ﬁ Symboles
ﬁ Transport

Mouveau theme...

=2

Personne

Titre

Artist-Fernalel

2

j«f 57 &

Figure

Artist-Fernaled
Artist-Malel
Artist-Male2

BusinessPerson-Fermalel

RurimarcDarcam_Farmalal

5 : La Galerie en vue détaillée

Dans la Galerie, les images sont groupées par thémes tels que Fleches, Symboles et Personne.
Vous pouvez créer d'autres groupes ou thémes et ajouter vos propres images ou trouver des
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extensions qui contiennent d’autres dessins. Cliquez sur un théme pour que son contenu s’affiche
dans la fenétre de la Galerie.

Vous pouvez utiliser un Affichage en icbnes (Figure 3) ou une Liste détaillée (Figure 5) et vous
pouvez masquer ou afficher la Galerie en cliquant sur le bouton Masquer du Volet latéral.

“ Remarque

Dans certaines installations, seul le theme Mon théme est personnalisable bien que de
nouveaux thémes puissent étre ajouté comme expliqué dans « Ajouter un nouveau
théme a la Galerie » page 14. Les thémes verrouillés sont faciles a reconnaitre par un
clic droit : la seule option disponible dans le menu contextuel est Propriétés.

Par défaut, la Galerie s'ouvre dans le Volet latéral. Vous pouvez la détacher comme les autres
panneaux : voyez le Chapitre 1, Présentation de LibreOffice, pour plus d’informations.

Ajouter des objets a la Galerie

Vous pouvez vouloir ajouter des images que vous utilisez souvent, par exemple le logo de votre
société, au dossier Mon theme de la Galerie. Vous pourrez ensuite insérer facilement ces images
dans un document.

1) Faites un clic droit sur le dossier Mon théme et cliquez sur Propriétés dans le menu
contextuel.

2) Dans la boite de dialogue Propriétés de Mon théme, cliquez sur 'onglet Fichiers (Figure 6)

Propriétés de Mon théme

Nouveau théme...

B Environnement Général Fichiers

& Finance
[ Fléches
1 Formes de texte Supprimer
Renommer

Type de fichier: |<Tous les fichiers> (*.*) i Rechercher des fichiers...

<Aucun fichier> Ajouter

[ Ordinateurs
[;J [E_EJ Mon théme

Figure 6 : La boite de dialogue Propriétés d'un théeme

Propriétés... Tout ajouter

Pour ajouter plusieurs fichiers en une seule fois :

1) Cliguez sur le bouton Rechercher des fichiers.

2) La boite de dialogue Sélectionner un chemin s’ouvre. Vous pouvez saisir le chemin du
dossier des fichiers dans la zone de texte Chemin ou vous pouvez parcourir les dossiers
pour le trouver.

3) Cliquez sur le bouton OK pour lancer la recherche. Une liste de fichiers graphiques
s’affiche alors dans la boite de dialogue Propriétés. Vous pouvez utiliser la liste déroulante
Type de fichier pour limiter les fichiers visibles.

4) Pour ajouter tous les fichiers de la liste, cliquez sur Tout ajouter. Sinon, sélectionnez les
fichiers a ajouter puis cliquez sur Ajouter (appuyez sur la touche Maj ou la touche Ctrl
en cliguant sur les fichiers).

Pour ajouter un fichier unique :

1) Cliguez sur Ajouter pour ouvrir la boite de dialogue Gallery.

2) Utilisez les contrdles de navigation pour rechercher l'image a ajouter au théme.
Sélectionnez-la et cliquez sur Ouvrir pour I'ajouter.

3) Cliguez sur OK dans la boite de dialogue Propriétés de Mon théme pour la refermer.

Il est également possible d’'insérer dans la Galerie par simple tirer-déposer un objet que vous avez
créé (dans Draw par exemple), mais cela requiert de suivre précisément la procédure suivante :
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1) Cliguez avec le bouton gauche de la souris sur I'objet pour le sélectionner.

2) Cliquez avec le bouton gauche de la souris et maintenez-le enfoncé sans bouger pendant
un temps « suffisant ». Ce temps dépend de la disponibilité du systéme pour mettre en
mémoire cette image, mais normalement 1 seconde doit suffire.

3) Tirez I'objet et déposez-le dans la Galerie.

Si I'objet est simplement déplacé dans le document lors du déplacement de la souris, c'est que
Vous n'avez pas attendu assez longtemps ou que l'objet n'était pas sélectionné au départ.

Supprimer des images de la Galerie
Pour supprimer une image d’'un théme :

1) Faites un clic droit sur le nom du fichier image ou de sa miniature dans la Galerie.

2) Cliquez sur Supprimer dans le menu contextuel. Un message vous demande de confirmer
la suppression de I'objet. Cliquez sur Oui.

“ Remarque

Supprimer un objet dans la Galerie n’efface pas le fichier correspondant sur le disque
dur ou un autre emplacement. Par contre si I'objet a été incorporé a partir de
LibreOffice par tirer-déposer, il est alors définitivement supprimé.

Ajouter un nouveau théme a la Galerie
Pour ajouter un nouveau théme a la Galerie :

1) Cliquez sur le bouton Nouveau théme au-dessus de la liste des thémes (Figure 5).

2) Dans la boite de dialogue Propriétés de Nouveau théme, cliquez sur I'onglet Général et
tapez un nom pour le nouveau théme.

3) Cliquez sur I'onglet Fichiers et ajoutez des images au theme comme décrit ci-dessus.

Supprimer un theme de la Galerie
Pour supprimer un theme de la Galerie :

1) Sélectionnez le menu Insertion > Média > Galerie.
2) Choisissez dans la liste des thémes celui que vous désirez supprimer.
3) Faites un clic droit sur ce theme puis cliqguez sur Supprimer dans le menu contextuel.

Emplacement de la Galerie et des objets qu’elle contient

Les images et les autres objets visibles dans la Galerie peuvent étre situés n’'importe ol sur le
disque dur de votre ordinateur, sur un disque réseau ou tout autre support amovible. Quand vous
ajoutez des images a la Galerie, les fichiers ne sont ni déplacés ni copiés : I'emplacement des
nouveaux objets est simplement ajouté en tant que référence.

Dans un groupe de travail, vous pouvez avoir accés a une Galerie partagée (dont vous ne pouvez
pas modifier le contenu sauf autorisation) et a une Galerie personnelle ou vous pouvez ajouter,
modifier ou supprimer des objets.

L'emplacement de la Galerie personnelle est défini dans Outils > Options > LibreOffice >
Chemins. Vous pouvez modifier cette localisation et copier les fichiers de votre galerie (SDV) sur
d’autres ordinateurs.

Le contenu de la Galerie fournie avec LibreOffice est stocké a un emplacement différent que vous
ne pouvez pas madifier.
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e Remarque

Les themes de la Galerie sont empaquetés pour la distribution par I'intermédiaire du
systéme d’extensions de LibreOffice. Dans ce cas, I'emplacement des fichiers
graphigues est déterminé par le paramétrage de l'extension. Pour obtenir d'autres
themes pour la Galerie, rendez-vous sur le site web des extensions de LibreOffice a
http://extensions.libreoffice.org.

Créer une image cliquable

Une image cliquable posséde des zones (appelées zones sensibles) reliées a des adresses web,
d’autres fichiers sur I'ordinateur ou d’autres parties du méme document. Les zones sensibles sont
I'équivalent graphique des hyperliens textuels (décrits dans le Chapitre 12). Quand on clique sur
un zone sensible, LibreOffice ouvre la page liée dans le programme approprié (par exemple, le
navigateur par défaut pour une page HTML, LibreOffice Calc pour un fichier ODS, un lecteur de
PDF pour un fichier PDF). Vous pouvez créer plusieurs zones sensibles de formes variées et en
inclure plusieurs dans la méme image.

Pour utiliser I'éditeur d'images cliquables :
1) Dans votre document, cliquez sur I'image dans laquelle vous voulez créer les zones
sensibles.
2) Sélectionnez le menu Edition > Image Map dans la barre de Menu. L’éditeur d’lmage Map
s’ouvre (Figure 7).
3) Utilisez les outils et les champs de la boite de dialogue (décrits ci-dessous) pour définir les
zones sensibles et les liens nécessaires.

4) Cliquez sur I'icone Appliquer = pour appliquer les paramétrages.

5) Quand vous avez terminé, cliquez sur l'icbne Enregistrer B pour enregistrer I'image

cliquable dans un fichier puis sur le X dans le coin supérieur droit pour fermer la boite de
dialogue.

Sélectionnez un outil Rectangle, Ellipse ou Polygone pour dessiner une zone sensible sur votre
image.
Sous la barre d’outils, précisez pour la zone sensible sélectionnée :

* Adresse : I'adresse visée par I'hyperlien. Vous pouvez aussi pointer vers une ancre dans
un document ; pour cela, écrivez 'adresse avec ce format :
file:///<path>/document_name#anchor_name

* Texte : tapez a cet endroit le texte qui doit apparaitre quand le pointeur de la souris survole
la zone sensible.

+ Cadre : précise I'endroit ou la cible de I'hyperlien va s’ouvrir ; choisissez parmi _blank
(dans une nouvelle fenétre du navigateur), _self (dans la fenétre du navigateur actif), _top
ou _parent.

> Conseil

La valeur _self pour le cadre ciblé fonctionne normalement parfaitement. |l n'est donc
pas recommandé d'utiliser les autres choix sauf nécessité absolue.
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Figure 7 : L'éditeur d'Image Map qui permet de créer ou de modifier une image cliquable

Utiliser les outils de dessin de LibreOffice

Vous pouvez utiliser les outils de dessin de LibreOffice pour créer des schémas simples formés de
rectangles, de cercles, de lignes, de texte et d’autres formes prédéfinies. Vous pouvez aussi
grouper plusieurs objets dessinés pour étre certain de conserver leurs positions et proportions
relatives.

Vous pouvez placer les objets dessinés directement sur une page de votre document ou les
insérer dans un cadre.

Vous pouvez aussi vous en servir pour annoter des photographies, des captures d’écran ou
d’autres illustrations produites par d’autres programmes mais cela n’est pas recommandé, car :

« Comme il n'est pas possible d’inclure des images dans un groupe d'objets de dessin, elles
peuvent ne pas rester alignées dans votre document.

* Si un document est convertit dans un autre format, comme HTML, les objets de dessin et
les images ne resteront pas associés : ils seront enregistrés séparément.

D’'une maniéere générale, si vous devez créer des figures complexes, il est recommandé d’utiliser
LibreOffice Draw qui posséde plus de fonctions telles que les couches, les styles, etc.
Créer des objets dessinés

Pour commencer a utiliser les outils de dessin, affichez la barre d'outils Dessin (Figure 8) en
cliguant sur Affichage > Barres d’outils > Dessin.

Si vous envisagez d'utiliser régulierement les outils de dessin, vous pouvez détacher la barre
d’outils et la placer & un emplacement pratique sur la fenétre.
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1 2 3 45 6 78 9 101112 13 14 15 16 17 18 19 20 21 22 23

1 Sélectionner 7 Rectangle arrondi 13 Formes de base 19 Légendes

2 Ligne 8 Carré 14 Formes des 20 Zone de texte
symboles

3 :‘éggg a mamn 4 Ellipse 15 Fléches pleines 21 Galerie Fontwork

4 Courbe 10 Cercle 16 Etoiles 22 Editer les points

5 Polygone 11 Triangle isocele 17 Légendes 23 (Dés)activer I'extrusion

6 Rectangle 12 Triangle rectangle 18 Organigrammes

Figure 8 : La barre d'outils Dessin
Pour utiliser un outil de dessin :
1) Cliguez dans le document a I'endroit ou vous voulez ancrer le dessin. Vous pouvez modifier
'ancrage plus tard si nécessaire.

2) Choisissez un outil dans la barre d’outils Dessin (Figure 8). Le pointeur de la souris change
selon la fonction de dessin choisie pour ressembler a celui-ci pour 'outil rectangle : -

3) Déplacer la mire du pointeur a I'endroit du document ol vous voulez voir apparaitre le
dessin puis cliquez et tirez pour créer I'objet. Relachez le bouton de la souris. La fonction
sélectionnée reste active pour que vous puissiez dessiner un autre objet du méme type.
Exception dans Draw, pour conserver le méme outil aprés avoir fait un premier dessin, il
faut au départ double cliquer sur le bouton dans la barre d’outils.

4) Pour désélectionner l'outil, appuyez sur la touche Echap ou cliqguez sur licéne
Sélectionner (la fleche) de la barre d’outils Dessin.

5) Vous pouvez alors modifier les propriétés (couleur de remplissage, type et épaisseur de
ligne, ancrage, etc.) de I'objet de dessin en utilisant : soit la barre d'outils Propriétés de
I'objet de dessin (Figure 9), soit les choix et les boites de dialogue auxquels vous accédez
par un clic droit sur cet objet, soit par le volet Propriétés du volet latéral.

Définir ou modifier les propriétés des objets de dessin
Pour définir les propriétés d’'un dessin avant de le tracer :

1) Sur la barre d'outils Dessin (Figure 8), cliquez sur I'outil Sélectionner.

2) Sur la barre d'outils Propriétés de l'objet de dessin (Figure 9), cliquez sur les icones des
propriétés et choisissez les valeurs que vous désirez pour celles-ci

3) Pour un meilleur contrdle, ou pour définir de nouveaux attributs, vous pouvez cliquer sur les
icones Remplissage et Ligne pour ouvrir des boites de dialogue détaillées.

Les valeurs par défaut que vous définissez s’appliquent au document et a la session en cours.
Elles ne sont pas enregistrées quand vous fermez le document ou Writer et elles ne s’appliquent
pas a un autre document que vous ouvrez. Elles s’appliquent a tous les objets de dessin sauf les
objets de texte.

Pour modifier les propriétés d’'un objet de dessin existant :
1) Sélectionnez I'objet.

2) Continuez comme décrit ci-dessus.

Vous pouvez aussi spécifier la position et la taille, la rotation et I'inclinaison ainsi que le rayon des
sommets de I'objet de dessin :

1) Faites un clic droit sur I'objet et choisissez Position et taille dans le menu contextuel. La
boite de dialogue Position et taille s’affiche.
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2) Modifiez les propriétés comme vous le désirez.

B ) oo ] s Mo - - TEEE b P00 B EE BY
1 2 3 4 5 6 7 8 91011 1213 14151617 18 19 20212223 24
1 Couleurdeligne 7  Modifier 'ancre 13  Aligner 19 A larriére-plan
2 Style de fleche 8 Pas d’adaptation 14 Envoyer a l'avant 20 Grouper
3 Style de ligne 9 Eaege\z/m relatif a la 15 \Vers l'avant 21 Entrer dans le groupe
4 Largeur de ligne 10 Renv0| dynamique 16 Vers l'arriére 22  Quitter le groupe
a la page

5 Style . de 11 Adaptauon 17 Envoyer a l'arriére 23 Dissocier

remplissage continue
6 Coule_ur de 12 Pivoter 18 Au premier plan 24 Légende

remplissage

Figure 9 : La barre d'outils Propriétés de I'objet de dessin

Modifier les dimensions d’un objet de dessin

On modifie les dimensions d'un objet de la méme maniére que celles d’'une image. Sélectionnez
I'objet, cliquez sur 'une des huit poignées qui I'entourent et tirez-la jusqu’a sa nouvelle taille. Les
proportions de l'objet ne sont pas préservées. Pour les préserver, maintenez la touche Maj
appuyée pendant le changement de dimensions.

Pour un contrdle plus précis de la taille de I'objet, sélectionnez Position et taille dans le menu
contextuel ou Format > Zone de texte et forme > Position et taille dans le menu principal. Vous
pouvez modifier les dimensions dans la page Position et taille. Si I'option Conserver le ratio est
cochée, les deux dimensions changent mais la proportion est maintenue ce qui produit un
changement d’échelle.

Grouper des objets de dessin

Le groupement d’objets de dessin facilite la manipulation de plusieurs objets sous forme d’'une
entité unique tout en préservant leurs tailles et positions relatives.

Pour grouper des objets de dessin :

1) Sélectionnez un objet puis maintenez la touche Maj appuyée en sélectionnant les autres
objets que vous désirez inclure dans le groupe. La boite de délimitation s’agrandit pour
incorporer tous les objets sélectionnés.

2) Quand les objets sont sélectionnés, sélectionnez le menu Format > Groupe > Grouper
dans la barre de Menu ou faites un clic droit sur un objet sélectionné et choisissez Groupe
> Grouper dans le menu contextuel.

e Remarque

On ne peut pas inclure une image incorporée ou liée dans un groupe avec des objets
de dessin.

> Conseil

Il est recommandé de préparer son dessin dans Draw avant de le copier-coller dans
Writer, ou de I'enregistrer dans la Galerie. Cela permet de bénéficier de davantage
d’outils.
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Utiliser Fontwork

Avec Fontwork, vous pouvez créer des objets d’art textuel graphique pour embellir votre travail.
Comme ces objets possédent de nombreux paramétres différents (ligne, remplissage, position,
taille, etc.), vous avez un large choix.

Fontwork est disponible dans tous les modules de LibreOffice mais vous remarquerez de petites
différences dans la maniére dont chacun I'affiche.

Créer un objet avec Fontwork

1) Pour ouvrir la Galerie FontWork, vous pouvez

— cliquer sur I'icdne Galerie de Fontwork dans la barre d'outils Fontwork (Affichage

> Barres d’outils > Fontwork) ou la barre doutils Dessin (Affichage > Barres
d’outils > Dessin),

— sélectionner le menu Insertion > Fontwork dans la barre de Menu.

2) Dans la Galerie de Fontwork (Figure 10), choisissez un style puis cliquez sur OK. L'objet de
Fontwork va apparaitre dans votre document. Remarquez les carrés de couleur autour des
bords (qui indiquent que I'objet est sélectionné) et le point jaune ; ils sont présentés dans
« Modifier la position et la taille des objets de Fontwork » page 23.

Galerie Fontwork q

Sélectionner un style Fontwork :

]

| FONtwyk FONVIO: ity

Fogfork <% S/ Eontwerk

Aide ] Annuler

Figure 10 : La galerie de Fontwork
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3) Faites un double clic sur l'objet pour modifier le texte de Fontwork (voir Figure 11).
Sélectionnez le texte et tapez le votre a la place du mot Fontwork qui apparait en noir par-

dessus l'objet.
O
o ‘ B
[
' O O

Figure 11 : Edition du texte d'un objet Fontwork

4) Cliguez dans un espace vide ou appuyez sur la touche Echap pour appliquer les
modifications.

Modifier un objet de Fontwork

Maintenant que l'objet Fontwork est créé, vous pouvez modifier certains de ses attributs. Pour
cela, vous pouvez utiliser la barre d’outils de Fontwork, la barre d’outils Formatage ou les options
du menu comme il est décrit dans cette section. Si I'objet Fontwork sélectionné est un objet 3D,
vous pouvez aussi utiliser la barre d’outils Parameétres 3D.

Avec la barre d’outils de Fontwork

Vérifiez que la barre d’outils de Fontwork, visible sur la Figure 12, est affichée. Si ce n'est pas le
cas, sélectionnez le menu Affichage > Barres d’outils > Fontwork. Cliquez sur les différentes
icones pour modifier les objets de Fontwork.

Fontwork v X

V-aa =&

Figure 12 : La barre d'outils de Fontwork

v Forme Fontwork : permet de modifier la forme de [ronmwor v X

T " i 2 . g

'objet sélectionné. Vous pouvez choisir dans une v-Az = -AW. &
palette de formes. 7 T|AA = T &

— OO\l

AV davw

NN

~v (D08

~v()OSE

Figure 13 : La barre d'outils
de Fonwork avec la palette
de formes

— Hauteur identiqgue pour les lettres Fontwork : modifie la hauteur des caractéres de

Aa I'objet. Bascule entre la hauteur normale (certains caractéres plus hauts que les
autres, par exemple les majuscules, d, h, I, etc.) et toutes les lettres de la méme
hauteur.
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Figure 14 : A gauche : lettres normales — A droite : lettres de méme hauteur

I
4

Alignement Fontwork: modifie lalignement des A\ =
caractéres. Vous avez le choix entre Aligner a gauche, T T @ﬁ
Centrer, Aligner a droite, Mots justifiés et Etirement
justifié. Les effets ne sont visibles que si le texte s’étend
sur deux lignes ou plus. Dans le mode Etirement justifié,
toutes les lignes sont complétement remplies.

Aligner & gauche
Centrer
Aligner a droite
Mots justifiés

Etirernent justifié

810 e )|

aw . Espacement des caracteres Fontwork: modifie awy | m
A 'espacement et le crénage des caractéres dans l'objet. & @I@
Faites votre choix dans la liste déroulante. Trés serré
Serré
& Normal
Large
Tres large

4

Personnalisé...

~  Créner les paires de caractéres

%@ Activer ou désactiver I'extrusion pour obtenir un objet en
2D ou en 3D.

Utiliser la barre d’outils Formatage
Maintenant pour aller plus loin, il est possible de personnaliser I'objet de Fontwork avec plusieurs
attributs supplémentaires.

Cliquez sur I'objet de Fontwork. La barre d'outils de Formatage est remplacée par la barre d’outils
Propriétés de I'objet de dessin pour afficher les options qui permettent de modifier I'objet. (La barre
d’outil visible sur la Figure 15 apparait quand vous utilisez Fontwork dans Writer.)

Cette figure montre la barre d’outils flottante. Par défaut, elle est ancrée sous la barre de menu.
Sur la figure, elle a aussi été personnalisée pour montrer toutes les options disponibles ; par
défaut, seule une partie d’entre elles sont visibles.

La barre d'outils Propriétés de I'objet de dessin offre un grand choix d’options pour personnaliser
votre objet. Ce sont les mémes que pour les autres objets graphiques. Pour plus d’informations,
voyez le Guide Draw.

Options de lignes
* Icone Ligne : ouvre une boite de dialogue avec trois onglets : Ligne, Styles de ligne,
Styles de fleche. Utilisez I'onglet Ligne pour modifier les propriétés les plus courantes des
contours de l'objet de Fontwork sélectionné en choisissant parmi les attributs
précédemment définis comprenant le style et la couleur de ligne et le style de fleche.
Utilisez les onglets Styles de ligne et Styles de fleche pour modifier les propriétés des
lignes et des styles de fleche et en définir de nouveau.

» Palette Couleur de ligne : choisissez la couleur de la ligne.
* Icbne Style de fleche : faites votre choix parmi les différents styles de fleches.
+ Liste Style de ligne : faites votre choix parmi les styles de lignes proposeés.
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* Liste Largeur de ligne : définissez la largeur de la ligne.

Propriétés de

1 2 3 4 5 6 7 8
I'ohjet de dasiL ‘ | |
T & ﬁ e ‘C__‘K " 003 cm [ @ |Degrade V|

Ce

12 13 14 15 16 17 18 19 20 21 22 23 24 25 26 27 28 29 30 31 32

1 Modifier I'ancre 9 Coule_ur de 17 Adaptation continue 25 Grouper
remplissage

2 Ligne 10 Pivoter 18 Mode contour 26 Entrer dans le groupe
3 Couleurdeligne 11 Aligner 19 Envoyer a l'avant 27 Quitter le groupe
4 Style de fleche 12 Pas d’adaptation 20 Vers l'avant 28 Dissocier
5 Style de ligne 13 Eaeg(\a/m relatif a la 21 \Vers l'arriere 29 Légende
6 Largeurdeligne 14 gitla:\‘;c;lggynamlque 22 Envoyer a l'arriére 30 Afficher la grille

7 Remplissage 15 Adapter a gauche 23  Au premier plan 31 Aligner sur la grille
8 Style' de 16 Adapter a droite 24 A larriere-plan 32 ngnes daide lors du

remplissage déplacement

Figure 15 : La barre d'outils Propriétés de I'objet de dessin

Options de remplissage
* Icone Remplissage : ouvre une boite de dialogue possédant sept onglets : Remplissage,
Ombre, Transparence, Couleurs, Dégradés, Hachures et Bitmaps.

Onglet Remplissage : choisissez dans les listes prédéfinies une couleur, un bitmap, un
dégradé ou un motif de hachure pour remplir I'objet sélectionné.

Onglet Ombre : définissez les propriétés de 'ombre de I'objet sélectionné.
Onglet Transparence : définissez les propriétés de transparence de I'objet sélectionné.

Onglet Couleurs : modifiez les couleurs disponibles ou ajoutez-en de nouvelles qui
apparaitront dans I'onglet Remplissage.

Onglet Dégradés : modifiez les dégradés existants ou ajoutez-en de nouveaux qui
apparaitront dans I'onglet Remplissage.

Onglet Hachures : modifiez les motifs de hachures proposés ou ajoutez-en de
nouveaux qui apparaitront dans I'onglet Remplissage.

Onglet Bitmaps : créez des motifs bitmaps simples et importez-en d’autres qui seront
disponibles dans I'onglet Remplissage.

» Listes Style de remplissage : choisissez le type de remplissage de l'objet sélectionné.
Pour un paramétrage plus précis, utilisez I'icbne Remplissage.

Options de positionnement
* Icdne Pivoter : faites tourner manuellement I'objet sélectionné avec la souris.

* Icbne Au premier plan : déplace I'objet sélectionné devant le texte.
+ Icone A l’arriére-plan : déplace 'objet sélectionné derriére le texte.
* Icdne Aligner : modifie I'alignement des objets sélectionnés.

* Icdnes Envoyer a I’avant/Vers I’avant : déplace I'objet sélectionné devant tous les autres
ou devant celui qui est au-dessus de lui.
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* Icones Envoyer a l'arriére/Vers I'arriére : déplace I'objet sélectionné derriere tous les
autres ou derriére celui qui est sous lui.

* Icdne Ancrer : choisissez parmi les options d’ancrage :

— A la page — I'objet conserve une position fixe par rapport aux marges de la page. Il ne
bouge pas quand vous ajoutez ou supprimer du texte.

— Au paragraphe — I'objet est associé a un paragraphe et se déplace avec lui. Il peut étre
positionné dans la marge ou a un autre emplacement.

— Au caractére — I'objet est associé a un caractére mais n’est pas dans la suite du texte. Il
se déplace avec le paragraphe mais peut étre placé dans la marge ou a une autre
position. Cette méthode est voisine de I'ancrage au paragraphe.

— Comme caractére — I'objet est placé dans le document comme n’'importe quel caractére
et se déplace avec le paragraphe quand vous ajoutez ou supprimer du texte avant
I'objet.

* Icone Dissocier : sépare une sélection d'objets groupés pour que vous puissiez les gérer
individuellement.

* Icdne Grouper : groupe les objets sélectionnés pour que vous puissiez les gérer comme
un objet unique.

Utiliser les options du menu

Vous pouvez utiliser les choix du menu Format pour ancrer, aligner, positionner et grouper les
objets de Fontwork sélectionnés, adapter le texte autour d’eux et les retourner horizontalement et
verticalement.

Vous pouvez aussi faire un clic droit sur I'objet de Fontwork et choisir beaucoup de ces options
dans le menu contextuel. Celui-ci propose aussi un acces rapide aux boites de dialogue Ligne,
Remplissage, Texte et Position et taille. La boite de dialogue Texte n’offre que peu d’options pour
les objets de Fontwork et il n’est pas présenté ici. Dans le dialogue Position et taille, vous pouvez
saisir des valeurs précises pour la taille et la position. Pour plus d’'informations sur ces options de
menu, voyez le Guide Draw.

Utiliser la barre d’outils Parameétres 3D

Si I'objet de Fontwork sélectionné est un objet 3D, vous pouvez aussi utiliser les options de la
barre d'outils Parametres 3D (Figure 16). Vous pouvez aussi changer un objet de Fontwork en 2D
en objet en 3D (ou un objet en 3D en objet en 2D) en cliquant sur I'icobne (Des)activer I’extrusion
de la barre d’outils Fontwork (Figure 12). Pour plus d'informations, voyez le Guide Draw.

Parameétres 30 v X
@ - % - - ¥ - -

S&d % | g Tﬂ -]

Incliner vers le bas, Direction Surface

le haut, la gauche

ou la droite Profondeur  Eclairage  Couleur 3D

Figure 16 : La barre d'outils Paramétres 3D

Modifier la position et la taille des objets de Fontwork

Quand vous sélectionnez un objet de Fontwork, huit carrés colorés (appelés poignées)
apparaissent autour des limites de I'objet comme on le voit ci-dessous. Vous pouvez tirez ces
poignées pour modifier la taille de I'objet.
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Un point jaune apparait aussi sur I'objet. Il peut
se trouver sur un bord de I'objet ou n'importe
ou ailleurs ; dans I'exemple, il est a droite. Si
vous survolez ce carré jaune avec le pointeur
de la souris, celui-ci se transforme en main.
Vous pouvez tirer le carré dans différentes
directions pour déformer I'objet.

Survoler un autre endroit de I'objet avec le
pointeur de la souris redonne a celui-ci sa
forme habituelle pour tirer I'objet & un autre
emplacement de la page.

Pour un contrdle précis de la position et de la
taille de l'objet, utilisez le menu contextuel
Position et Taille.

D
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